Computer Sound Card Interface

ELK-129

The ELK-129 Computer Sound Card Interface allows
a computer’s speaker output to be used as one of the
tools for programming the ELK Recordable Modules,
such as the ELK-120, ELK-124, or ELK-MV480. The
included shareware software is used to process your
computer’s audio files for use with the ELK-129. The
ELK-129 then “downloads” the processed files to the
Recordable Module. Finished messages can be
saved on your computers hard drive for re-use.

Features

» Powers ELK-120 or ELK-124 Modules during Programming.
* Power Switch.

 Audio Jacks for Computer and Speakers.

* Plug-In Cable for Quick Connections to Recordable Modules.
* Includes 6 foot Shielded Cable for Speakers.

» Compact Plastic Case.

» Programs Recordable Modules in Seconds!.

* Lifetime Limited Warranty.

Specifications / Requirements

» Size:4.4"x3"x 1.15" (111.8mm x 76.3mm x 29.2mm).
» Supplies 12Volts D.C. @ 1 Amp for ELK-120/ 124 Modules.
» Requires Windows 3.1 or higher, 386 processor or better,
4MB RAM, 2MB Hard Drive Space, 3 2" Floppy Drive,
Stereo Speaker Output Jack or Sound Card and computer speakers.
* Requires (1) 12V, 20VA AC Transformer (not included) to program
the ELK-120 or ELK-124. Transformer is not needed for
the ELK-MM447 or ELK-MV480.

Features and Specifications subject to change without notice.
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129 Overview

APPLICATION

All ELK Voice Recordable Annunciator Modules can record & store voice, music or sound effects for later playback. There
are basically two methods to record sound into the Recordable Modules; 1st is by pressing the Recordable Module’s Record
Switch and speaking directly into the on-board Microphone, the 2nd is to use the ELK-129 Interface to allow computer audio
files such as .WAV files to be “played” and recorded into the Recordable Module. One advantage of using an ELK-129 &
computer is that unique sounds gathered from the internet or other sources can be edited and stored on a computer and then
be recorded into multiple Recordable Modules at any time.

OPERATION

This manual assumes that your computer has a functional 3.5mm stereo speaker output jack and speakers. Adjust the
computer’s volume to the half-way mark. The ELK-129 was originally designed for use with ELK-120 and ELK-124 version 1
Recordable Modules. Since newer Recordable Models have been added to ELK'’s product line, the ELK-129 operates slightly
differently on the these modules as described below.

If you have an ELK-MM447 or ELK-MV480:

You need the ELK-129 PLUS an ELK-MK485 Programmer’s Kit or ELK-MK400 Magic Module Starter Kit. Either of these
two kits can be used. They contain the software needed for programming an MM447 or MV480. The ELK-129 is only required
for completion of the audio connections. Refer to the instructions that are supplied with the MM447 or MV480.

You do not need the Sound Recording Software (floppy disk) included with the ELK-129 and you do not need a Transformer
for powering the ELK-129. The remainder of these instructions are also not needed, they are intended only for the ELK-120/
124 Recordable Modules.

If you have an ELK-120 or ELK-124:

You need the ELK-129 PLUS a plug-in AC step down Transformer (not included), and the Sound Recording Software (floppy
disk) included with the ELK-129.

A 16.5 Volt, 40VA Transformer can be used, although a 12 Volt, 20VA Transformer is recommended since it will not overdrive
the ELK-129. We caution against leaving a 16.5V plugged in when the ELK-129 is not in use as it can become warm to the
touch after a time.

The Sound Recording Software installs a shareware program called Cool Edit™ along with a supplied automated “Script” file
(elk-120.scp) which processes computer audio files ((WAV) for auto recording the ELK-120/124 modules. Auto recording is
defined as a way to trigger the record command and then play (record) a computer audio file ((WAV) into the Recordable
Module.

About Scripting... Audio files that will be auto-programmed into ELK-120 or ELK-124 modules must be properly processed by
using the “Script” file before they can be used by the ELK-129. This process is described as follows: If the audio file is a
stereo recording, the left channel will be erased and replaced by a control track. If the audio file is a monaural recording, the
file will be converted into stereo before the control track is embedded in to the left channel. The control track is used to
automatically trigger the record mode on the Recordable Module when a "scripted” audio file is played. In addition to embed-
ding a control track, the script also "pads" the beginning of the right audio channel with 30mS of silence (this prevents the
beginning of your file from getting "chopped off" during programming). The remainder of the right channel (your audio file)
remains unchanged. The script automates the entire process for you, allowing you to program with just a few button clicks.
After running the script, just play the audio file to record it into the Recordable Module. Scripted audio files can be saved on
your computer's hard drive for re-use.

*Cool Edit is a Trade Mark of Syntrillium Software Corporation, P.O. Box 60274, Phoenix, AZ 85082-0274. This program is

shareware and requires a $50 registration for the full version, or $25 for the Lite version.
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129 Software Installation (ELK-120/124 ONLY)

NOTE: The following ELK-129 Sound Recording Software installation is not required for the ELK-MM447 or ELK-MV480
modules. These modules are programmed through the Magic Module Programming Software. See previous page.

If you have an ELK-120 or ELK-124:
Please read through the manual before starting.
Insert the ELK-129 Installation disk into your 3 %2” floppy drive and run SETUP.EXE as follows:

Windows 3.1: In Program Manager, click on the File menu. Under the File menu, select Run. Type A:\SETUP (or the
correct disk drive letter for your 3 %2” floppy), then click on OK.

Windows 95-98-2000-XP: Click in the Start button in the left corner of the startus bar. Then click Run and type A\SETUP
(or the correct disk drive letter for your 3 %2” floppy), then click OK.

The Setup program will guide you through the installation. Normally, you should choose the default directory suggested by
setup, but you may change the drive and / or directory, if needed. Once setup has finished, find the new program group
labeled Cool Edit. Click on the Cool Edit icon to start Cool Edit. Read & close the license agreement, then Press OK to
get past the registration screen.

To test Cool Edit, click on the File menu, then click Open and double-click on the ELK120 directory. You may need to
double-click on the COOL folder first, if you are not already in this directory (the product folder(s) is located beneath the
COOL folder). You should see the channel one and channel two default audio message files there (ch1l.wav and ch2.wav).
Click on one of these files and then click OK. Click on the Play button to hear the file. If you do not hear the file playing
from your computer’s speakers, check the computer’s volume settings. If your computer came with a “mixer” program,
make sure all of the sliders or knobs are turned up and no outputs are muted. If you have determined that the volume
control is turned up and you still don't hear the file when you click on Play, check to make sure your speaker cable is
plugged into the correct jack on the computer and on the speakers themselves. Also, make sure the speakers are turned
on (amplified speakers only), and that their volume is turned up. Make sure speakers are connected to a power adapter
(and that the adapter is plugged into the AC). You can close the Cool Edit program for now.

ELK-120 / 124 Versions 1 & 2 Hardware

ELK-120/124 Versions 1 & 2 Channel Activations as related to the ELK-129 Operation:
This section describes how channels are activated (triggered) on various Recordable Modules. A channel must be
activated (playing) to accept a new recording. Channels on version 1 modules can be activated by using SW1 on the
ELK-129. Version 2 modules use SW1 in addition to DIP Switches to activate the desired channel to be recorded.

« ELK-120 V1 Original version featuring 2 Voice Channels of 10 seconds each.
Turn SW1 to CH1 to activate Channel 1 or to CH2 to activate Channel 2.

« ELK-120 V2 Version 2 featuring 4 Voice Channels of 120 seconds each and DIP switches to select channel to be recorded.
Turn SW1 to CHL1 to power the module, then move any DIP Switch to the ON position to activate a corre-
sponding channel.

» ELK-124 V1 Original version featuring 4 channels of 30 seconds each.
Place ribbon cable on J1, move SW1 to CH1 to record Channel 1 or move SW1 to CH2 to record Channel 2.
Place ribbon cable on J2, move SW1 to CH1 to record Channel 3 or move SW1 to CH2 to record Channel 4.

* ELK-124 V2 Version 2 featuring 8 channels of 60 seconds each. Set Channel Polarity jumpers to “+”. Turn SW1 to CH1 to
power the module, then move any DIP Switch to the ON position to activate a corresponding channel.



Recording Hookup (ELK-120/124 ONLY)

The recording hookup requires the following supplied items:

1-
1-
1-

ELK-129 module.
1 foot, 5-pin ribbon cable.
6 foot shielded audio cable.

You will need the following items, which are not supplied:

1-
1-
1-

12 Volt, 20VA step down AC transformer.
Length of 2-conductor (zip cord) wire for connection of the transformer.
Windows based computer with 16-bit stereo speaker output jack, speakers, and some audio files. (WAV)

1- Recordable Module. (ELK-120 or ELK-124)

1-

8 ohm (15-30 watts recommended) speaker for playback of the recorded messages. (if desired)

Refer to Figure 1 when making the following connections:

1.

Strip the ends of the 2-conductor wire and connect one end to the step down transformer and the other end to the AC
terminals on the ELK-129 (located under the cover). Plug the transformer into an AC receptacle. To confirm the power
connection to the ELK-129, move the power switch to CH1 and look for the Power Led “ON”. Return SW1 to the center
"OFF" position.

. Always be sure SW1 is off before making any connections to the ELK Recordable Module or the ELK-129

interface. Plug the 5-pin ribbon cable onto the polarized connector J1 on the ELK-129. Plug the other end onto the
Programmer input of the Recordable Module. (Refer to the Recordable Module’s instruction manual for programmer input
location)

Remove the audio cable from the back of the computer speakers and plug it into the AUDIO IN Jack on the ELK-129.
Plug one end of the supplied 6-foot shielded audio cable into the AUDIO OUT Jack. Plug the other end of this cable into
the computer speakers, where the first cable was originally plugged. If your speaker cable is wired directly to the speaker
with no jack, plug the speaker cable into AUDIO OUT and connect the 6-foot shielded cable between the computer and
AUDIOIN.

Connect a speaker (8 ohms, 15-30 watts recommended) to the speaker terminals of the Recordable Module. Adjust the
module’s volume control to a minimum level before turning on the ELK-129.

When programming an audio file from the computer, into the Recordable Module, make sure to disable the on-board
microphone on the Module. Refer to the Recordable Module’s instruction sheet for location of the on-board microphone
jumper. Make sure your computer’s microphone is either off, unplugged, or muted. This will prevent room noises from
being recorded along with your messages. Make sure jumper JP2 is set to “Repeat” mode (single play disabled).

To prevent short circuits, keep the units away from metal surfaces while power is applied. To prevent electrical noise
(EMI) from being induced into the recording, keep the Recordable Module and the ELK-129 as far away as possible from
sources of electrical noise such as video monitors and transformers.

Place SW1 on the ELK-129 to the CH1 position. For ELK-120 or 124 version 2 Recordable Modules, also move DIP
switch #1 to the ON position. Adjust the Recordable Module’s volume control until you hear the default channel 1 mes-
sage playing at a comfortable level. If channel 1 has been erased, you may not hear anything at all.

. Once you have confirmed that the Recordable Module and the ELK-129 are properly connected, you are ready to begin

the programming process (you may turn off CH1 or DIP sw #1 for now).



Hookup (ELK-120/124 ONLY)
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Your First Programming Session

NOTE: This section explains how to program an ELK-120 or ELK-124. For other ELK Recordable Modules models, please refer to
the installation instructions that accompany the Recordable Module.

If you have completed the hookup and software installations, you are ready to program your first unit.

In the following steps, you will use the factory default ELK-120 Channel One and Channel Two .WAYV files (supplied by the
setup program) or use your own audio files to help setup the proper computer volume levels. Cool Edit will be used to add a
control track to the left channel of both wav files. A special script file (similar to a macro or batch file) has been included to
automate this process.

1. Click on the Cool Edit icon to start Cool Edit. Read & M Lo

File Edit Transform Generate Options Help
close the license agreement, then Press OK to get past 7 [ 5 5 R )
the registration screen. —

e 2

2. Click on the File menu and select Open. In the Directories
window, double-click on the ELK120 directory.

3. In the File Name window, click on the chl.wav file, then
click on OK.

4. When the file has finished loading, you should see a Zoomn | t | 11025 / 16 bit / Mana Beg: 0.00.000
— . 06591 Samples En
screen similar to Figure 2. Play | | o T Recod g e 000568
)
Figure 2.
Cool Edit - CH1.WAY (=[Ol =]

File Edit Transform Generate | Options Help
"lglmlgg ﬁ I:IE Lnnp.Mnda
T Monitor YU Lewel
Settings...
Info... Al
Frequency Analysis Alt+Z
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5. Click on the Options menu, then select the Cool Scripts /
Batch Process... submenu (see Figure 3).

Cue List

Zoom n_ | | | 11025 / 16 bit / Mono Eeg: 0:00.000
106591 Samples End:
Play_| | | Record |55z Tirme: 0:09.568
||
o 1ol ]
Figure 3. : T : S E:
71 Y e o = 7 ) e
Cool Scripts
Title of Collection: Hew Script
[none loaded] T |
Title
6. In the Cool Scripts window, click on Open / New (see [pensiion | I |
Figure 4). | I |
T

I Script works on cument wave

0:00.000

X Pause at Dialogs
X Alent when complete
[T Execute Relative to Cursor

| 009668
.

Bls_ &

Figure 4.



Programming Confinved
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7. Inthe Directories window, double-click on the ELK120
directory (located under the COOL directory). T[::’n:'lga":::;“’" Hew Script
Please choose a scrlpt file B :
8. Inthe File Name window, click on the file ELK120.SCP, File Name: st
then press OK (see Figure 5). [FLK120.5CP |o-tcoohelk120 j
P (see Figure 5) m o —
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Figure 5.
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9. Make sure the Pause at Dialogs and the Execute
Relative to Cursor boxes are not checked. In the ELK Title of Colloction: New Sciipt
Recording Utilities window, click on Embed Control R Tiwe [
Track, then click on Run (Figure 6). The ELK-120 Script o Co\ —grack Do =
will not run if any portion of the waveform has been "se- (o ] .
lected" (highlighted). If any of the waveform has been [Batch Run]
selected, press the Esc key to exit the script dialog box,
then press Esc again to unselect the waveform. | o p—
Zoy

Lt [" Pause at Dialogs
[" Alert when complete
L [ Execute Relative to Cursor

This script will properly format a sound sample fol the E
hlnck of cilanca will ha nlacad at the haninninn tha «

Figure 6.

10. When the script has finished, you should see two distinct B TETRIIRIES - [0] ]
waveforms, similar to Figure 7. The right channel has the =B LR T =R E
original waveform (with 30mS of silence added to the '
beginning). The left channel should appear as a constant
20 Hz sine wave that runs the entire length of the record- R
ing. Your waveform has now been processed and is ready

to be "downloaded"!

You can now save the “scripted” ch1l.wav to your hard
drive if you wish to load this message into another
Recordable Module at a later date. Click File, Save As,

. . o . ZoomIn | | { 11025 /16 bit / Stereo Beg: 0:00.000
enter a different file name to keep the original file un- Fiay | | T Record |22 Samples End: 0.09.967
H EEOrd P09 K Time: 0:09.957
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Figure 7.



Programming Confinved

11. Adjust your computer’s volume to the half-way mark. Place ribbon cable from ELK-129 to J1 on the Recordable Module.
You must apply power to a channel in order to record it. Channels are activated differently depending on which version of
Recordable Module you have as noted below.

12a For ELK-120 Version 1 Modules, (has no dip switch) .. skip to step 13.
12b. For ELK-120 Version 2 Modules, (has dip switch) ... Move DIP Switch #1 to the ON position .. skip to step 13.
12c. For ELK-124 Version 1 Modules, (has no dip switch) ... skip to step 13.
12d. For ELK-124 Version 2 Modules, (has dip switch) ... Move DIP Switch #1 to the ON position .. skip to step 13.

13. Turn SW1 on the ELK-129 to CH1. Channel one's message should start playing. In Cool Edit, click on the PLAY button or
press the spacebar to start playing ch1l.wav. If the computer’s volume level is high enough, the RECORD / EOM LED on
the Recordable Module should come on solid, indicating the message is being recorded. The Recordable Module will
playback the message just recorded. If the LED does not come on solid while Cool Edit is playing the file, you will need
to increase your computer’s volume output before trying again. If your volume is already set to maximum, see the
Troubleshooting section for more help.

14. Ifthe Recordable Module’s message sounds distorted during playback, try reducing your computer's volume control and
repeating step 13. You can normally double-click the small speaker icon in the task bar to adjust the volume or L-R
balance. To reduce distortion, use the lowest volume setting that will trigger the Recordable Module. If the message still
sounds distorted, try shifting the L-R balance toward the left control track channel (if your computer supports balance
adjustment). You may need to run the "mixer" program that came with your computer to do this. Do not shift the balance
completely to the left (this mutes the right channel). The balance control will be directly above the Master Volume slider.
Click on the center triangle shaped pointer and slide it to the left. If it does not slide, your computer may not support
balance adjustment.

15. When you have successfully programmed the message for Channel One, you may proceed to program Channel Two by
placing SW1 on the ELK-129 to the CH2 position. For ELK-120 or 124 version 2 Recordable Modules, also move DIP
switch #1 to the OFF position, then turn DIP Switch #2 to the ON position. Repeat Steps 1-14, loading the file ch2.wav
instead of chl.wav.

16. Once you have mastered the programming process, try recording your own custom messages or sound effects with Cool
Edit. With a little experimenting, you can build an impressive library of custom sounds and messages.

17. After installation, the ELK-120/ 124 selection jumpers should be set for the desired operation. i.e. disable record switch,
repeat/ 1shot mode, DIP switches OFF, and the channel polarity jumpers on the ELK-124 v2.

Note: If you wish to record by speaking directly in to the on-board microphone, the ELK-129 can still be utilized for providing
power to the Recordable Module. However, you must unplug the cables from the AUDIO IN and AUDIO OUT jacks to prevent
interference. Make certain that the on-board microphone is enabled by placing JP1 in the correct position. For example: To
record a message on Channel One, place SW1 on the ELK-129 to CH1, (for ELK-120 or 124 version 2 Recordable Modules,
also move DIP switch #1 to the ON position), then press and hold the RECORD push-button on the ELK-120 or ELK-124
Recordable Module while speaking into the built-in microphone. For Channel Two, repeat the above step, placing SW1 on
the ELK-129 to CH2. (for ELK-120 or 124 version 2 Recordable Modules, also move DIP switch #2 to the ON position, and
DIP switch #1 OFF).



Troubleshooting

If you have followed all of the previous steps and still cannot get the Recordable Module to program, here are some trouble-
shooting hints:

1. Make sure the audio file has been properly processed with the Cool Edit script. A properly processed file will look similar
to Figure 7 on page 7 when loaded into Cool Edit.

2. Make sure the audio is getting to the ELK-129. When playing your audio file with Cool Edit, you should hear your file
coming out of the RIGHT channel. You may only hear a 20 Hz buzzing or popping sound coming from the LEFT channel.
Confirm this by plugging a pair of headphones that are marked with L and R into the AUDIO OUT jack. If your file is heard
through the LEFT channel, you should run the Swap Channels script in Cool Edit. This will automatically swap the left
and right channels in the audio file.

3. Ifyou hear the audio coming from the correct channels, try increasing the computer's volume output while playing the file
in Loop Mode (select Loop Mode under the Options menu). This will change the PLAY button into a LOOP button.
Pressing LOOP will cause the sound file to repeat endlessly, allowing you to adjust the volume to the proper setting.
Once you find the correct setting, press STOP to end looping and prevent overrunning the time limit for channel one. If
your volume is already at maximum, be sure you are using the computer’s speaker output jack instead of a line output
jack.

4. If none of the above hints work, try manually pressing the Recordable Module’s RECORD switch and clicking on PLAY at
the same time. Shortcut: press the spacebar to start and stop playing, instead of clicking PLAY. If this works, you may
have to use this manual method when programming. Some computer’'s may lack the fidelity to reproduce the 20 Hz
control track at a sufficient level. If the manual method does not work, then there may be a problem in the hookup or with
one of the units.

Making Recordings with CoolEdit

1. Use a good quality microphone.

2. Observe the VU meters (the bar graph at the bottom of the screen). Try to keep your recording levels around -9 to -6 dB.
If your levels exceed 0 dB, the sound will be distorted.

3. Record in a quiet area. Keep the microphone away from hard surfaces such as walls and table tops.

4. Record your messages at 11-22 khz sampling rate. Always choose 16 bit recording. Don't bother making the recording in
stereo, since the script will create a new left channel anyway.

5. If you want to add special effects to a sound file (echo, stretch, etc.), you should do so before running the Embed
Control Track script. This will insure that the control track does not get corrupted. If you have already run the script and
want to add effects to the file, you may still do so. After you have added the effects, run the Re-do Control Track script
to reformat the control track channel. Note: Some effects (such as stretch) will change the length of your audio
file. Use care to prevent overrunning the Recordable Module’s recording time limit.

6. Read Cool Edit's on-line help files to become familiar the program's features. Don't forget to register Cool Edit! Select
Help, Registration Form to view or print out a registration form.

Note: Until you register Cool Edit, you can only choose from two categories of special effects when you start the program.
Choose any effect you would like to try first, but you must always choose Save, External Clipboard Functionality and
Sample Converting as one of the categories if you plan on saving your file to disk.



